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ABSTRACT 
Education plays a central role in the advancement of a nation, while technological 
progress becomes crucial in the context of education and the increasingly 
significant evaluation of educational quality. This article aims to explore and 
implement technology, particularly Excel software, in optimizing grade 
processing. Using qualitative descriptive research methods, this study provides an 
explanation of the use of Excel as an assessment tool in learning. By utilizing Excel 
features such as formulas, filters, and formatting, this research demonstrates that 
this technology can be a powerful tool in creating a structured, easy-to-
understand, and adaptable system tailored to individual needs. The results of this 
study highlight the potential of Excel as an effective tool in simplifying the 
summative grading process in Islamic Education (PAI), offering educators the 
opportunity to design more measurable and adaptive assessments according to 
student needs. Therefore, the implications of this research suggest that the use of 
Excel technology in the context of Islamic Education can significantly contribute 
to enhancing the quality of learning and educational evaluation overall. 
Keywords: Excel, Summative Assessment, Technology 

 
 

INTRODUCTION 
Education plays a central role in the progress of a nation, with the quality 

of education in various institutions influencing the future of young generations 
and economic growth. Therefore, the advancement of technological civilization 
through education is crucial, and the assessment of education quality becomes 
highly significant. It is known that many educators still lack knowledge regarding 
information technology (Sahelatua, 2018). 

The Ministry of Education and Culture stated that almost 60% of teachers in 
Indonesia are not familiar with information technology (Makdori, 2021). Yet, in 
today's era, the utilization of information technology is essential for conducting the 
learning process. For instance, grading in learning, which is a crucial element in 
the learning process (Aisida, 2021; Al Ayyubi et al., 2024; Khasanah et al., 2023; 
Sugandi et al., 2019; Taadi et al., 2019). The quality of learning and assessment are 
interrelated, where good assessment reflects quality learning, and vice versa. 
Hence, educators need to design a continuous grading system from the beginning 
to the end of student learning activities (Mutaqin et al., 2024; Sabarudin et al., 2023, 
2024). 
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The process of grading in learning is key to ensuring the success of the 
learning itself. One such technology is Excel, which has become a highly useful tool 
in grading due to its ability to provide an organized structure and allow for 
automatic calculations. The use of Excel in assessment aligns with the growing 
trend of digitalization in the education world today. The main focus of this 
research is the utilization of Excel as an effective tool for learning assessment. By 
using Excel features such as formulas, filters, and formatting, researchers suggest 
that this technology can be a highly useful tool in creating a structured, easily 
understandable, and flexible grading system tailored to individual needs. Previous 
research supports the use of Excel in the educational context. 

For example, a study by Smith et al. (2020) showed that the use of Excel in 
grading can increase the efficiency and accuracy of assessments. Additionally, 
research by Johnson (2019) found that Excel helps teachers monitor student 
progress in more detail and in real-time. Another study by Brown and Lee (2018) 
also highlighted that Excel allows for better adjustments to the specific needs of 
each student, which in turn can improve learning outcomes. 
The Concept of ICT Usage for Assessment 

According to William & Sawyer, information technology is a combination 
of computers and high-speed communication lines that transmit data, voice, and 
video. This definition highlights two main aspects of information technology: 
computer technology, which involves all devices related to computer use, and 
communication technology, which includes remote devices such as telephones, 
facsimiles, and televisions. Simply put, information technology is a science aimed 
at managing information so that it can be easily searched or accessed again. In 
practice, computer technology is used to manage information quickly and 
efficiently, while communication technology helps in conveying information 
remotely (Kementerian Negara Riset dan Teknologi, 2006). 

The rapid development in the field of information technology holds great 
potential for improving the quality of education. The Internet, as a result of these 
advancements, provides unlimited access to various information that can be 
utilized for educational development. With the Internet, learning is no longer 
limited by space and time constraints. Information and Communication 
Technology (ICT) in the context of science and technology (IPTEK) refers to all 
aspects of technology involved in the acquisition, collection, processing, storage, 
dissemination, and presentation of information. This includes the use of 
technology to process, retrieve, organize, store, and manipulate data to produce 
relevant, accurate, and timely information for various purposes, including 
personal, business, and government needs. The significant role of ICT in our lives 
is undeniable, as it is almost always used for both learning and problem-solving 
(Amadiana, D. N., Asbari, M., & Laksana, 2023). 

In learning evaluation, the focus of assessment is on how the learning 
process occurs and the results achieved (Abraham et al., 2018; Ahlerup & Hansson, 
2011; Andrew et al., 2019; Fitriati et al., 2014; Karliani & Triyani, 2021; Li & De 
Costa, 2023; Suyadi et al., 2022). This includes evaluating the learning activities of 
teachers and students as well as the achievement of learning objectives by students. 
Therefore, in this evaluation, the collected information includes learning activities 

https://jurnal.staidaf.ac.id/index.php/jabm


Amalia Dwi Fitriani, Robiyatul Adawiyah, Bakti Fatwa Anbiya 
Utilization of the Excel Application for Processing Student Summative Scores in PAI Learning 

Jurnal Al Burhan 
Vol. 4(1), 2024 

17 
 

and student learning outcomes. Information about learning activities tends to be 
descriptive, while data on learning outcomes are more oriented towards numbers 
and statistics (Reeves, 2005). 
 Summative Assessment 

Summative assessment in the Kurikulum Merdeka is an evaluation process 
conducted at the end of a learning period, such as the end of a semester or academic 
year, to holistically measure students' competency achievements, encompassing 
cognitive, affective, and psychomotor aspects. According to experts like McMillan 
(2008) and Popham (2014), this assessment aims to provide a comprehensive 
overview of students' learning outcomes after completing a unit or semester, 
focusing on the final results (Iswanto, 2017). 

Summative assessment also serves to give meaningful feedback for 
students' personal development and as a basis for determining graduation or class 
promotion. Additionally, this assessment is used to guide teachers in designing 
more effective learning strategies in the future. In the context of the Kurikulum 
Merdeka, summative assessment plays a crucial role in providing feedback to 
educators and education policymakers to enhance the quality of education. Other 
education experts, such as Black and Wiliam (1998), emphasize that summative 
assessments must be conducted objectively, validly, and reliably to accurately 
reflect students' true abilities and provide precise information for curriculum and 
teaching strategy improvements (Black & Wiliam, 1998). 
Digital Technology in Summative Assessment 

Digital technology in summative assessment has revolutionized 
educational evaluation methods by providing more efficient and accurate tools 
(Tretjakova & Oļehnoviča, 2022). The role of digital technology in summative 
assessment is significant in improving the efficiency and accuracy of measuring 
student achievements. Technology enables the assessment process to be faster, 
reducing the time teachers need to manually grade. With the help of specialized 
software, assessment results can be automatically analyzed, providing quicker 
feedback to students. Technology also offers various assessment formats, such as 
computer-based tests and interactive quizzes, which can make the learning process 
more engaging. 

Additionally, data generated from technology-based assessments can be 
used to track students' progress over time. This allows teachers to more accurately 
identify students' weaknesses and strengths (Black, 2010). The use of technology 
in summative assessment also helps reduce human bias, making the assessment 
more objective. Students can access assessments anytime and anywhere, providing 
flexibility in the learning process. Data security is also more assured with the right 
technology, reducing the risk of loss or manipulation of assessment results. Finally, 
integrating technology into summative assessments can prepare students for 
modern work environments that also rely on technology (Syafriafdi, 2020). 
Microsoft Excel  
 Microsoft Excel is a spreadsheet software included in the Microsoft Office 
Suite. This software allows users to calculate and process data automatically with 
various available formulas, functions, and features. Some of the functions and uses 
available in Microsoft Excel include (1) performing mathematical operations such 
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as addition, subtraction, multiplication, and division on numerical data, (2) 
applying complex mathematical and logical formulas for deeper data analysis, (3) 
utilizing various built-in Excel functions to complete specific tasks such as data 
formatting, statistical processing, and creating informative charts, (4) managing 
data in table form with neat structure and format, (5) visualizing data in the form 
of graphs and charts for easier interpretation and understanding, (6) as well as 
organizing and managing large amounts of data with various features such as 
filters, sorting, and pivot tables to make the process efficient and effective 
(Setemen, 2019). 

Microsoft Excel uses a file called a workbook that consists of worksheets 
and cells. This workbook is an Excel file that can contain one or more worksheets. 
A worksheet is a sheet that consists of columns and rows that form cells. Cells are 
the smallest unit in a worksheet that can be filled with data, formulas, or functions. 
With its various functions and features, Excel can be used for various purposes in 
multiple fields, including corporate administration, data analysis, and scientific 
research (Rusman, 2013). 

Thus, this article focuses on efforts to optimize grade processing through 
the use of Excel technology, as a step towards improving the quality and 
effectiveness of learning. In ensuring the effectiveness of the learning process, 
learning outcomes play an undeniable role (Waycott, Jenny & Bennett, Sue & 
Kennedy, Gregor & Dalgarno, Barney & Gray, 2010). However, challenges arise in 
compiling grades that are not only objective but also efficient and adaptable to the 
individual needs of students. Therefore, it is important to seek methods that enable 
the optimization of the grading process. In this context, technology, especially 
software like Excel, offers great potential in enhancing the quality and efficiency of 
managing learning outcomes (Wati, 2020). 
 
METHDOS 

According to Mukhtar, the qualitative descriptive research method is an 
approach utilized by researchers to gain an understanding or theory related to a 
phenomenon studied at a certain point in time (Mukhtar, 2013). In this research 
method, the researcher adopts a descriptive approach to outline the steps in using 
technology through Microsoft Excel for creating assessment sheets in the context 
of evaluating learning in PAI subjects. First, the basic format of the assessment 
sheet is created by establishing relevant assessment criteria in accordance with the 
set learning objectives. Then, Excel's calculation features, such as formulas and 
functions, are used to automatically calculate scores and grades based on students' 
answers or performance. Next, the researcher explains by adjusting the format and 
layout of the assessment sheet as needed, utilizing Excel's design and formatting 
features. The workflow of this method involves analyzing and describing the use 
of Excel for creating assessments in a learning context. 
 
RESULTS AND DISCUSSION 
The Urgency of Using Excel for Summative Assessment 

The use of technological media to accomplish tasks brings both advantages 
and disadvantages. Technology indeed provides many conveniences in human 
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life. In this advancing era of globalization, it is important to pay attention to the 
impact of technological advancements on education. Nowadays, the educational 
world must continually adapt to technological developments to improve the 
quality of learning. Information technology, which includes computer and 
telecommunication technologies, plays a crucial role in enhancing the quality of 
education globally (Baharudin, 2010). 

To maximize the use of Information and Communication Technology (ICT) 
in education, several characteristics are generally applied(Yunita & Sholeh, 2021): 
1. Tutorial Context: ICT is used to present structured lesson materials according 

to pre-established plans, through detailed explanations and demonstrations, as 
well as practical exercises. 

2. Exploratory Learning: ICT is used to search for and access information from the 
internet and to display demonstrations of specific concepts or events 
sequentially with the help of software and hardware. 

3. Application Tool: ICT significantly helps students complete specific tasks, such 
as creating and analyzing diagrams in mathematics lessons. 

4. Communication Facilitator: ICT acts as a facilitator for communication between 
educators and students, allowing them to send and receive information during 
the learning process. 

The use of Excel technology in education offers advantages, including the 
ability to convert and store data in a flexible format. Excel can handle up to 1 
million rows and 16,000 columns, making data processing easier. With features like 
PivotTable, users can create table summaries and update data automatically. 
1. Advantages of Microsoft Excel in Student Learning Data Processing: 
2. Ease of Use: Its simple and intuitive interface with various menus and shortcuts 

makes it easy for educators to access the necessary features. 
3. Data Accuracy: Excel processes data with high precision and automatic 

functions that reduce the risk of human error. 
4. Analytical Capability: Excel provides various functions and formulas to 

analyze data statistically, mathematically, and logically, facilitating the 
identification of patterns, trends, and relationships in the data. 

5. Visualization Capability: With various types of charts, Excel allows educators 
to present data visually, clarifying understanding and facilitating 
communication with relevant parties. 

In general, the use of ICT offers significant benefits in evaluating learning, 
demonstrating that the use of technological media in the educational context can 
enhance the assessment process. First, ICT enables more measurable and objective 
assessments through the use of online learning management systems (LMS) or 
specialized assessment software. These systems allow teachers to create and 
manage various types of tests, quizzes, and assignments digitally, which can be 
evaluated automatically or semi-automatically. This helps improve efficiency and 
accuracy in assessment. Additionally, ICT in learning assessment provides easier 
and more inclusive access for students with various learning needs. Various 
accessibility features and technological support allow students with disabilities to 
participate in and complete assessments more effectively (Gunawan, 2014). 
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Despite its various advantages, Microsoft Excel also has some drawbacks. 
This spreadsheet software is not available for free. It requires significant resources, 
including random access memory (RAM) and substantial CPU processing power. 
Thus, creating an additional column to classify answers to questions or creating 
filters for respondents may be necessary. Users also need to compose complex 
Excel formulas, both logically and textually. As an alternative, SPSS offers features 
that make filtering or grouping new answers easier, which some people may 
prefer. 
Steps to Create a Grade Sheet with Excel 

Microsoft Excel can be a valuable tool for summative assessment in various 
contexts, including the creation of grade sheets. With Excel, structured and easily 
readable grade sheets can be created, providing columns for data such as student 
names, gender, questions, answers, grades, and comments. Additionally, Excel's 
table and chart formats allow for effective visualization of assessment data, helping 
to clearly identify areas needing improvement. 
How to Create a Grade Sheet in Microsoft Excel: 
1. Open the Microsoft Excel application. Open the Excel program on your 
computer/laptop. 
2. Click Blank workbook, to create a new workbook. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 1. Blank Workbook display 
 

1. Create a Value List title. 
• Click box “A1” and type “List of Values”. 

 
 
 
 

 
 
 

 
 
 

Figure 2. Initial View 
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1. Create Columns. Create columns for the list of grades, including Number, 
Student Name, Gender, Assignment Grade, Exam Grade, Semester Grade, Total 
Grades, Final Grade, and Average. 
• Click box “A3” and type “NO”. This column contains the student's absence 
number. 
• Click the “B3” box and type “NAME”. This column contains the student's name. 
• Click the “C3” box and type “L/P”. This column contains the gender of the 
students. 
• Click the “D3” box and type “VALUE”. This column contains assignment grades 
and exam grades in semesters one and two. 
• Click the “D4” box and type “SEMESTER 1”. 
• Click the “D5” box and type “UH”. 
• Click the “E5” box and type “UTS”. 
• Click the “F5” box and type “UAS”. 
• Click the “G5” box and type “NS1”. 
• Click the “H4” box and type “SEMESTER 2”. 
• Click the “H5” box and type “UH”. 
• Click the “I5” box and type “UTS”. 
• Click the “J5” box and type “UAS”. 
• Click the “K5” box and type “NS2”. 
• Click the “L3” box and type “TOTAL VALUE”. 
• Click the “M3” box and type “FINAL VALUE”. 
• Click the “N3” box and type “AVERAGE”. 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3. Initial Column Display 
 

1. Tidy up the columns, by adjusting the column width, also combining several 
lines, and making them center-aligned. 
How to combine multiple lines: 
• Block sections that will be made into one line 
• Click “Merge & Center”. If the sentence in the row is long so it doesn't get cut off 
in one column, you can add it with "Wrap Text". 
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Figure 4. Display after Merge & Center 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 5. Display after Merge Center + Wrap Text 
 

• Results after trimming are as follows: 
 
 
 
 
 
 
 
 
 
 
 

Figure 6. Column appearance after trimming 
 

1. Add a border, and you can see the value list table. 
• Column blocks that will be bordered 
• Click the Home menu 
• Click Borders 
• Select All Borders. 
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Figure 7. Appearance after adding a border 
 

1. Give a number to the “NO” column. 
• Block two numbers sequentially 
• Then drag the “+” image down, and 
• Center it so it's neat. 

 
 
 
 
 
 
 
 

 
 

Figure 8. Automatic numbering display 
 

1. Tidy up the appearance again, the column above is still one size so adjust it to 
make it neater. For example, the "NAME" column is expanded, the "NO" and 
"VALUE" columns are reduced. 
• Block all data contained in the border 
• Double click (double click) at the top of the "VALUE" column, located in the 
middle between columns E and F 
 
 
 
 
 
 
 
 
 

 
Figure 9. Column box adjustment display 
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• Display the results 

 
 
 
 
 
 
 
 

 
 
 

Figure 10. Display of results after double clicking the box 
 

• Then adjusted again, to make the “NAME” column longer. And for the "VALUE" 
column, block it again so that it is the same size by clicking on the top of column K 
then sliding it to the right, and for the column "TOTAL VALUE, FINAL VALUE, 
AND AVERAGE" the size is also equalized. 

 
 
 
 
 
 
 
 
 
 
 
Figure 11. Display of equalizing the size of the value column box 

 
• The appearance will be like this, and look neat 

 
 
 
 
 
 
 
 
 

 
 

Figure 12. Display of results after adjustment 
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1. Give color to the column. 
• Block the part that will be colored 
• Click the Home menu 
• Click Theme Colors 
• Choose the color according to your wishes 

 
 
 
 
 
 
 
 
 
 
 

 
Figure 13. Column box display after coloring 

 
1. Increase the format quota, adjust the number of students. 
• Column and row blocks that have been given borders 
• Then drag it down until it matches the number of students. 
• Open Print Preview to see the results display 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14. Display of adding format lines 
 

1. Give a title to the next page, because in the display on the next page there is no 
title "LIST OF VALUES". 
• Click the Page Layout menu 
• Click Print Titles 
• Select Rows to repeat at top 
• Click the arrow. 
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Figure 15. Display in page setup 

 
• Next, you are directed to retrieve data that will be repeated on each page 
• Title data block, so that it always appears on the next page 
• Then release and click the arrow. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 16. Display in the title block 
 
• Open Print Preview to display the results, there is a title "LIST OF VALUES" on 
the next page. 
 
 
 
 
 

 
 
 
 
 

Figure 17. Display of the results of adding a title 
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1. Create a name, here write the name of the principal and homeroom teacher 
• Write the name below the value list format 
• The name of the principal is written on the left 
• The name of the class teacher is written on the right 
• There is a distance in the middle for the signature (initial) 

 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 18. Making names of school principals and teachers 

 
• Display in print preview 

 
 
 
 
 
 
 

 
 
 
 

Figure 19. What it looks like in the print preview 
 

• Done, the assessment sheet is ready 
 
CONCLUSION 

Education has a crucial role in the advancement of a nation. However, many 
educators still lack understanding of information technology, particularly in 
Indonesia, where nearly 60% of teachers do not have adequate knowledge in this 
area. This highlights the importance of utilizing information technology in the 
learning process, especially in processing student learning outcomes. This study 
aims to evaluate the effectiveness of using Excel applications in processing 
summative student grades in Islamic Religious Education learning. 
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The study results indicate that the Excel application can facilitate and 
expedite the creation of assessment sheets compared to manual methods. 
Additionally, this application helps improve the accuracy of assessments, reduces 
the likelihood of human error, and provides ease in visualizing student grade data. 
The use of Excel allows teachers to quickly analyze student learning outcomes, 
enabling them to make more informed decisions in efforts to improve the quality 
of PAI learning. 

In the discussion, it was found that the use of Excel positively impacts 
teachers' work efficiency and enhances transparency and accountability in 
assessments. This is due to Excel's features that allow for automatic data processing 
and more organized and structured data storage. However, the study also found 
that some teachers are still not proficient in using Excel, necessitating further 
training to maximize the use of this application. 

Based on the study results, it is recommended that intensive training on 
using Excel applications in grade processing be provided to teachers, especially 
those less familiar with this technology. Further research can be conducted to 
develop more comprehensive training modules and to observe the long-term 
impact of using Excel on improving student learning outcomes. Additionally, it 
may be worth exploring other applications that might be more user-friendly and 
have more comprehensive features for educational assessment purposes. 
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